
 
© 2013 Tacony Corp, all rights reserved 

 
 

MasterWorks III -  Heirloom Cutwork 
 

I. Backdrop and Plan 

A. Open a New Page  and turn on 3D . 

B. Left click on the Backdrop tool  

1. In the MasterWorks Artwork folder select Lineart13 and click 

Open   

a) In MasterWorks III (C:\Designer’s Gallery\MasterWorks 
III\Artwork\Lineart13) 

2. Left click on zoom to fit  

C. Plan The Sewing Order 

1. It is tempting to just jump in and start creating stitches, but if you take a moment to 
plan first you will spend less time editing and re-sequencing later. 

2. If you make a list of the elements of your design in the order you want to sew them 
and note what type of stitching you want to use in each area you will be able to follow your 
list to quickly create an embroidery design that will stitch in the most efficient manner 
possible. 

D. When planning cutwork embroidery, think about the texture of the stitch effects you are 
selecting. 

1. Traditional cutwork designs are most often sewn with thread that is the same color as 
the background fabric. 

2. In this type of embroidery the open holes of the cutwork, and the texture created by 
different types of embroidery stitches become very important. 

3. Although we will use satin stitches for most of the design, we will also add some 
detailing with column fill stitches, chain stitches and Candlewicking knots. 

E. The butterfly list 
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1. Outline lower left wing - satin outline 

2. Outline of lower right wing - satin outline 

3. Run stitch travel stitches up middle of body to upper wing 

4. Outline of upper right wing -  satin outline 

5. Outline of upper left wing -  satin outline 

6. Run stitch travel stitches up middle of body to antennae 

7. Left and right antenna - motif chain stitch 

8. Single candlewick knot at the end of each antenna 

9. Body – Auto Column  

10. Detail on upper wings - reverse appliqué. 

11. Small spots on lower wings –cutwork 

12. Large spots on lower wings - cutwork with Richelieu bars. 

 

II. Lower Wings  
A. Trace the outline of the lower left wing 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click along the outline of the wing to trace it. 

a) This is a new drawing tool in MasterWorks III  

b) If you have clicked in the wrong place and want a re-do on any of your points, 
use the Backspace key on the keyboard. Each time you touch Backspace one 
blue Bezier point will be removed. 

c) Right click to end the line. 

B. Select stitch effect for the wing 

1. Left click on Apply Stitches  to open the menu 

2. Left click on Satin  to put a satin stitch outline around the wing 

3. In the Properties box, change the Width to 4.0mm and click Apply  

C. Edit the stitching for the smoothest sewing path. 

1. Left click on the Reform tool  

2. Move both the green start point and the red stop point to the end of the line next to 
the body of the butterfly. 

a) To move the start and stop points simply click and drag them to the desired 
position. 
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b) Either click Apply  in the Properties box or right click on the 
background of the design page to make the start and stop points remain in their 
new positions. 

D. Use Copy and Paste to create a wing on the lower right. 

1. Left click on the Select arrow  

2. Select the wing stitching  

3. Right click and Copy 

4. Right click and Paste 

5. Left click on the Modify tab 

6. Left click on Flip Horizontal  

7. Click and drag the wing into position on the right side of the butterfly using the 
backdrop picture to guide the placement of the wing. 

8. Left click on the Home tab 

 

III. Traveling Stitches 
A. The next step will be to add some straight stitches that will allow us to “travel” to the spot 
where the upper right wing will begin. 

1. Using traveling stitches will allow the machine to sew continuously instead of stopping 
to tie off, trim, and move the carriage to the next piece of embroidery. 

a) Traveling stitches were not needed for the two lower wings because the 
distance between the wings was short enough that a jump stitch will be created. 

2. Both the jump and the traveling stitches will be covered up when the body is stitched. 

B. Draw the line for the traveling stitches 

1. Left click on the Artwork tool  to open the menu 

2. Select the Line tool  

3. Left click up from the end of the lower wing up the body to the top of the right upper 
wing where it joins to the body. 

4. Right click to end the line 

C. Apply Run stitches to the line 

1. Left click on Apply Stitches  to open the menu 

2. Select Run  

3. Note in the Properties box that the stitching is a Single run with a stitch length of 
3.0mm. 
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4. Left click on the Reform tool  

5. Make sure that the green start point is at the bottom of the line and the red stop point 
is at the top of the line. 

 

IV. Upper  Wings 
A. Draw the line for the upper right wing 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click along the outline of the wing to trace it. 

4. Right click to end the line 

B. Select stitch effect for the wing 

1. Left click on Apply Stitches  to open the menu 

2. Left click on Satin  to put a satin stitch outline around the wing 

3. In the Properties box, change the Width to 4.0mm and click Apply  

C. Edit the stitching for the smoothest sewing path. 

1. Left click on the Reform tool  

2. Move both the green start point and the red stop point to the top end of the line next to 

the body of the butterfly and click Apply  
D. Use Copy and Paste to create a wing on the upper left. 

1. Left click on the Select arrow  

2. Select the wing stitching  

3. Right click and Copy 

4. Right click and Paste 

5. Left click on the Modify tab 

6. Left click on Flip Horizontal  

7. Click and drag the wing into position on the left side of the butterfly using the backdrop 
picture to guide the placement of the wing. 

8. Left click on the Home tab 

E. Run the Sewing Simulator to see that the wing outlines are sewing correctly. 
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V. Using Run Motif  Stitches 
A. We will be using motif stitches for the antennae, so let’s take a look at how these stitches 
work before we create our antennae 

1. Left click on New  to open a new design page. 

2. Turn on 3D  

3. Left click on the Artwork tool  to open the menu 

4. Select the Line tool  

5. Draw a horizontal line on the page  

a) Left click once at the left end of the line  

b) Then left click at the right end of the line 

c) Right click to end the line 

6. Left click on Apply Stitches  to open the menu 

7. Left click on Run Motif   

8. Left click on Zoom to fit  

B. Select a motif stitch  

1. Open the Motif list in the Properties box and select motif f023. 

2. Click Apply  

C. In the Properties box 

1. Stitch Length controls the size of the motif. 

a) Change the stitch length to 6.0 and click Apply  

b) And the stars get bigger. 

c) The stars are taller and fewer stars fit onto the line because they are also 
wider. 

2. Run Spacing changes the space between motifs. 

a) Change the run spacing to 1 and click Apply   
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b) A straight stitch appears between the stars and the points of the stars no 
longer touch each other. 

c) Change the run spacing to 5 and click Apply   

d) A longer stitch is placed between the stars. 

D. Select a new motif stitch 

1. Open the Motif list and select motif f013 

2. Click Apply  

3. Change the Stitch Length to 5 

4. Click Apply  

5. All of the arms on this feather stitch are angled toward the right. 

E. How to control which way the motif stitch faces 

1. Left click on the Reform tool  

a) The line of stitches is being sewn from left to right. 

b) We know that because the green start point is at the left end of the line and the 
red stop point is at the right end of the line. 

2. To turn the motif in the other direction we will need to sew it in the other direction. 

a) Click and drag to move the green start point to the right end of the line. 

b) Click and drag to move the red stop point to the left end of the line. 

c) Click Apply  

d) And the stitches face in the other direction! 

F. Create a single motif stitch 

1. Draw a line to be used to create our single motif 

2. Left click on the Artwork tool  to open the menu 

3. Select the Line tool  
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a) Draw a horizontal line that is about an inch long on the page.  

(1) Use the ruler at the top of the page to guide this.   

(2) It does not have be exact, close counts! 

b) Right click to end the line 

4. Left click on Apply Stitches  to open the menu 

5. Left click on Run Motif   

6. Select a new motif stitch 

a) Open the Motif list and select candlewicking03. 

7. Click Apply  

8. Change the Stitch Length to 5  

9. Click Apply and you will have a row of Candlewicking knots. 

 
10. In order to have just one motif on the line what we will need to do is make the line 
exactly the same length as one motif 

a) We know the length of one motif.   

b) Our stitch length is 5.0mm 

11. Right click on the ruler and select Metric so measurements will be given in 
millimeters for this next step 

12. Left click on the Transform tab in the Properties box 

a) Remove the check mark from the Maintain Aspect Ratio box so the width can 
be changed without affecting the height  

b) Change the width of the line to 5.0mm 

c) Click Apply  

d) And you will have a single knot!  

G. The easiest way to save the Candlewicking knot is to save it as a Quick Pick  

1. Select the Candlewicking knot 

2. Left click on the Tools tab 

3. Left click on Save Quick Picks   

4. Give your knot a name in the line for File name 

5. Left click Save  
 

VI. Antennae 
A. Return to the design page with the butterfly 
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1. In our case, we can left click on Design 1 tab  at the top of the design page 

2. Left click on the Home tab 

B. Draw the line for the traveling stitches 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click from the end of the wing up the body to the top of the head and then up the 
center of the antenna.   

a) Take the line all the way up to the tip of the antenna. 

b) The motif we will be using needs to sew from the end of the antenna to the 
head in order for the stitch to face the right way 

4. Right click to end the line 

C. Left click on Apply Stitches  to open the menu 

1. Select Run   

2. Note in the Properties box that the stitching is a Single run with a stitch length of 
3.0mm. 

D. Left click on the Reform tool  

1. Make sure that the green start point is at the bottom of the line and the red stop point 
is at the top of the line. 

E. Draw the line going back down toward the head for the motif stitch 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

F. Apply a motif stitch to the line 

1. Left click on Apply Stitches  to open the menu 

2. Select Run Motif  

 
3. Open the Motif window and scroll all the way to the bottom of the motif list. 

4. Select Pattern 1 and click Apply  

5. Change the stitch length to 2.5 and click Apply  
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G. Left click on the Reform tool  

1.  Check that the green start point is at the tip of the antenna and the red stop point is at 
the base of the antenna. 

2. If necessary, click and drag the start and stop points to the correct position and click 

Apply  

3. Sewing the antenna from the tip toward the head places the chain stitch so the points 
are facing the end of the antenna. 

H. Add traveling run stitches to the second antenna 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click across the head and up the center of the other antenna all the way to the tip 

4. Right click to end the line 

5. Left click on Apply Stitches  to open the menu 

6. Select Run   

a) Copy and paste was not used on the two antennae because the left antenna is 
a slightly different shape than the right antenna.   

b) Also the run stitches for the left antenna needed to include stitches that travel 
across the head to the second antenna. 

7. Note in the Properties box that the stitching is a Single run with a stitch length of 
3.0mm. 

8. Left click on the Reform tool  

9. Make sure that the green start point is at the bottom of the line and the red stop point 
is at the tip of the antenna. 

I. Draw the line for the motif stitches on the second antenna 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click along the middle of the antenna from the tip back to the top of the head. 

4. Right click to end the line 

J. Select stitch effect for the antenna 
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1. Left click on Apply Stitches  to open the menu 

2. Select Run Motif  

3. Open the Motif window and scroll all the way to the bottom of the motif list. 

4. Select Pattern 1 and click Apply  

5. Change the stitch length to 2.5 and click Apply  

K. Left click on the Reform tool  

1. Check that the green start point and the red stop point are both at the tip of the 
antenna. 

2. If necessary, click and drag the start and stop points to the correct position and click 

Apply  

L. Quick Pick Knots 

1. You will be able to use your Quick Pick  Candlewicking knot 

2. Left click on Quick Picks   

3. Open the Quick Pick list in the Properties box and select your knot. 

4. Left click on the design page to place a knot 

5. Left click again to place a second knot on the design page 

6. Left click on Select  

7. Select each knot and click and drag it to the tip of an antenna. 

M. The Candlewicking knots are a different color, but that is easy to change 

1. Open the Sequence View 

2. Select the orange color shown for the knots 

3. Left click on the same color chip you selected for the rest of the butterfly 

 

VII. The Body 

A. Draw the outline of the body 

1. Left click on the Artwork tool  to open the menu 

2. Select the Click 1 Curve tool   

3. Left click around the body of the butterfly 
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4. Left click on Close Shape  and right click to finish the shape 

B. Apply stitches to the body 

1. Left click on Apply Stitches  to open the menu 

2. Left click on Auto  to apply auto column stitching 

3. And a warning box opens to tell us that we have created satin stitches that are more 
than 10mm wide 

a) Stitches wider than 10mm are a problem because embroidery machines will 
generally not sew satin stitches that are wider than 10mm. 

b) This could cause us to have a bug body with gaps where the stitches were not 
sewn. 

4. Click OK  to close the warning box 

5. Open the Pattern window in the Properties box and select any pattern other than 
satin stitch and we will no longer have those too long stitches to worry about. 

a) Select the Snake Skin pattern and click Apply  

C. Select the Reform tool  

1. Confirm that both the green Start point and the red Stop point are at the top of the 
butterfly body 

2. If needed click and drag them to the top and click Apply  

D. Stitch settings for the bug body 

1. Column fills generally can be sewn with a slightly looser density than standard fills. 

a) This saves both time and thread, and you will have less density to consider 
when choosing a stabilizer. 

b) In the Properties box, change the Density to 0.5 and click Apply  

E. Select the Underlay tab on the Properties box 

1. Select both zig zag and contour underlay 

a) Click Apply  

b) I added more underlay to this section of the design after sewing the design the 
first time 

c) The body looked very flat next to the satin stitches of the wings. 

d) Adding more underlay gave this section of the design more dimension. 

F. New in MasterWorks III, set the traveling path in Properties 

1. You can see traveling run stitches along the edge of the body 

2. Left click on the Property box tab in the lower right corner of the page 

3. Open the Traveling Route window and select Along Middle 
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4. Left click Apply  

5. And the traveling stitches are now safely hidden under the body stitching  
G. Run the Sewing Simulator 

1. Before adding the decorative details to the wings this is a good time to double check 
the sewing order  

H. If any of the ends of the satin stitch outlines on the wings are not completely covered you can 
adjust that by moving the Bezier points 

1. Select the affected wing section 

2. Left click on the Reform tool  

3. Click and drag the Bezier points at the end of the line to lengthen the line so that the 
end of the stitching will be covered. 

4. Click Apply  

 

VIII. Reverse Appliqué 

A. In Reverse Appliqué the appliqué fabric is placed under a hole in the background fabric 
instead of being sewn on top of the background fabric. 

1. This is a technique that is useful when trying to use specialty fabrics that may be too 
heavy for traditional appliqué techniques. 

a) Heavy fabrics like fake fur may look better if they are applied from the back. 

b) This can also work well with fabrics that are too heavy to be easily trimmed if 
they are applied on top.   

c) With reverse appliqué, any raw edges that are not completely covered by the 
satin stitch will be on the wrong side of the fabric. 

d) And if necessary, you can always cover those raw edges with a fusible 
interfacing.    

(1) I use a fusible tricot interfacing for this.   

(2) White fusible tricot interfacing can be ordered through Nancy’s Notions. 
(a) PEK130W – White Pellon Fusible Easy Knit Interfacing 
(b) PEK130B – Black Pellon Fusible Easy Knit Interfacing 

2. The other use for Reverse Appliqué is to create a window in your fabric that is filled 
with a sheer fabric or lace 

a) This is what we will do with the large spots on the upper wings of the butterfly 

b) These spots could be filled with organza, or lace.   

c) Or for a true heirloom look you could use English netting. 

d) In this case you will not want to back the embroidery with interfacing since we 
are creating an embroidery design with open spaces. 

e) However, the netting, lace or organza will not ravel, so if a fabric edge is 
exposed on the wrong side of the design, it will not be a problem. 

 

IX. Appliqué in Upper Wings 

A. Trace the shapes of the spots on the upper wings 
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1. Select a turquoise blue in the color palette 

2. Left click on the Artwork tool  to open the menu 

3. Left click on  

4. Left click in the center of each of the spots in the upper wings 

B. Apply stitches to the spots 

1. Left click on Select  

2. Select all four spots 

a) The easiest way to do this is to select them in the Sequence View 

b) Simply select the blue part of the design in the Sequence View 

3. Left click on Apply Stitches  to open the menu 

4. Left click on Applique  

C. So why are the appliqué spots not 
turquoise? 

1. To see what happened with the 
colors 

a) In the Sequence View, left 
click on the plus sign to the left 
of the first appliqué 

b) Then left click on the plus 
sign to the left of the appliqué 
in the Sequence View. 

2. The turquoise is the first color of 
the appliqué 

3. The appliqué stitch effect uses 
color change to force the machine to 
stop sewing between the steps of the 
appliqué. 

D. Set the stitch settings 

1. Select all four appliqué spots in the Sequence View 

2. Change the Stitch length to 2.0  

a) The stitch length setting controls the stitch length of the straight stitches sewn 
in the first two color changes of the appliqué. 

3. Change the Applique width to 3.0 

a) Applique width controls the width of the satin stitch 

4. Click Apply  

E. How will the appliqué sew? 
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1. Run the Sewing Simulator to see how the appliqué spots will sew. 

2. Each spot will sew the three steps for its appliqué, and then the three steps for the 
next spot will sew. 

 

X. To Sew Reverse Appliqué 
A. The steps to sew a reverse appliqué are different from a typical 
appliqué because the appliqué fabric is applied to the back of an open 
hole on the background fabric. 

1. As discussed above, use organza, lace or English netting to 
fill these areas. 

B. To sew the reverse appliqué  

1. Hoop the fabric with Dissolve-Away Mesh stabilizer. 

a) This is a water soluble stabilizer so it can be 
completely removed from the open areas of the design 
with warm water. 

2. A run stitch outline will sew first to define the shape of the 
spot and then the machine will stop. 

3. Remove the hoop from the machine, but do not take the 
fabric out of the hoop 

4. Carefully trim the fabric out from the inside of the outline. 

a) Do not trim the stabilizer out of the hole 

b) The easiest way to lift the fabric so you can trim the fabric without cutting the 
stabilizer is to use a large pin. 

(1) I use a corsage pin, but any large 
pin will work 

(2) Place the pin through the fabric.   

(3) You can turn the hoop over and 
check the back to make sure the pin 
is not going through the stabilizer. 

(4) Insert the point of your scissors 
into the same hole where the pin 
goes in. 

(5) Again, if necessary you can look 
to the back to make sure you have 
only penetrated through the fabric, 
and not into the stabilizer. 

(6) Once you have cut the first slit in 
the fabric, you can remove the pin. 

(7) Cut with your scissors turned 
sideways and you will be able to trim just the fabric. 

5. Place the hoop back on the machine and slide the appliqué fabric under the hoop with 
the right side up.   

6. Sew the second straight stitch step of the appliqué 

7. Remove the hoop from the machine 
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8. Trim the appliqué fabric around the outside of the 
straight stitching 

a) You will be working on the back side of the 
fabric for this step 

9. Put the hoop back on the machine and sew the 
satin stitch.   

a) The satin stitch will cover both the raw 
edge of the hole and the raw edge of the 
appliqué fabric on the back. 

b) Remove the stabilizer to reveal the window 
created by the sheer fabric. 

 

XI. Small Spots on Lower Wings 

A. Trace the small spots 

1. Left click outside the design so nothing is selected. 

2. Select a green color chip in the Color Palette 

3. Left click on the Artwork tool  to open the menu 

4. Left click on  

5. Left click in the center of each of the small spots in the lower wings 

B. To sew cutwork 

1. Traditionally hand sewn cutwork was created by first sewing tiny straight stitches 
around the area that would be cut out. 

a) These little straight stitches act as stay stitches to keep the cut edge from 
stretching 

2. Then satin stitches were sewn to cover the raw edge. 

3. The stitch effect we have in MasterWorks that will sew straight stitches around an area 

and then follow with a satin stitch is Appliqué  

4. Left click on Select  and then select both of the small circles. 

C. Left click on Apply Stitches  to open the menu 

1. Left click on Applique  

D. Adjust the stitch settings in Properties 

1. Change the Stitch Length to 2.0. 

2. Change the Appliqué width to 3.0 

3. Left click Apply  
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E. To Sew Cutwork 

1. Sew the straight stitches 

2. To cut the fabric out of the center of the design 

a) Remove the hoop from the machine, but do not remove the fabric from the 
hoop 

b) Use a straight pin to lift the fabric away from the stabilizer 

c) Slide the point of the scissors in next to the pin to begin trimming. The goal is 
to trim the fabric without cutting the stabilizer. 

3. Cut with scissors flat against fabric to avoid cutting stabilize 

4. Put the hoop back on the machine and sew the satin stitch around the opening. 

 

XII. Large Spots on Lower Wings 

A. Trace the large spots 

1. Left click outside the design so nothing is selected. 

2. Select a pink color chip in the Color Palette 

3. Left click on the Artwork tool  to open the menu 

4. Left click on  

5. Left click in the center of one of the large spots in the lower wings 

B. Apply a stitch effect to the large circle 

1. Left click on Select  and then select the pink circle. 

C. Left click on Apply Stitches  to open the menu 

1. Left click on Applique  

D. Adjust the stitch settings in Properties 

1. Change the Stitch Length to 2.0. 

2. Change the Appliqué width to 3.0 

3. Left click Apply  

E. Richelieu Bars are used to add support to large cut areas.   

1. They are made up of lines of straight stitches bundled together by satin stitches sewn 
over them. 

2. Richelieu bars are used both as decorative elements and as a way to stabilize larger 
cutwork openings 

3. There are many different Richelieu Bar Patterns 

a) You can use a ladder in some areas 

b) Other areas could be filled with a cross or asterisk  

c) Use a fan shape  
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d) Or fill an area with a grid 

e) Any configuration of bars that enhances the shape of the cut area and supplies 
the support needed can be used  
 

 

4. Richelieu bars need to be anchored in the fabric under the satin stitching around the 
cut area.   

a) The bars should extend into the fabric outside of the straight stitching around 
the cut area.  

F. Create a Richelieu bar 

1. Select the large applique spot  

2. Zoom To Selection 

a) Left click on the arrow on the bottom of the zoom tool  to open the zoom 
menu 

b) Scroll down and left click on To Selection 

3. Change the Appliqué density so you can see the straight stitches through the zig zag. 

a) Change the applique density to 2.0 in the Properties box 

b) Left click Apply  

4. Left click on the Artwork tool  to open the menu 

5. Select the Line tool  
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a) Left click outside the straight stitches on one side and left click outside the 
straight stitches on the other side, and then right click to complete the line.   

b) This line should start and end as far outside the straight stitches as possible 
while still remaining under the zig zag stitches. 

G. Left click on Apply Stitches  to open the menu 

1. Left click on Satin   

2. Select the Reform tool   

a) Confirm that the green Start point is on one end of the line and the red Stop 
point is on the other end of the line. 

b) If necessary, click and drag the start and stop points to position them at 
opposite ends of the line. 

c) If you have moved the start and end points, left click Apply   

d) Change the Stitch width to 2.0 and click Apply  

3. We can use the underlay stitching to create the straight stitches and to bundle them 
before the satin stitch sews 

a) Select the Underlay tab in the Properties box 

b) Put checkmarks in both the Contour and the Zig-Zag types of underlay  

c) Left click Apply  

4. To see how the bar will sew 

a) Right click on the bar we just created in the Sequence View and select Hide 
Other 

b) To view the stitches that have been hidden,  

(1) Left click on the View tab 

(2) Left click on the Ghost  

(3) The hidden stitches will be displayed as white stitches  

(4) Those hidden stitches cannot be selected or edited and they will not be 
displayed by the sewing simulator 

c) Run the Sew Simulator to see how the bar will sew 

(1) The Contour underlay creates a straight stitch up one side and down 
the other 

(2) Then the Zig-Zag underlay sews a zig-zag up and back 

(3) The Satin stitch then sews over the top completing the bar. 

5. Right click on any item in the Sequence View and select Show All and all of the 
design will again be visible 

H. Create another Richelieu bar to form a cross in the open area 

1. Left click on the Home tab 
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2. Create running stitches to run over to the starting point for the  next Richelieu bar 

a) Left click on the Artwork tool  to open the menu 

b) Select the Click 1 Curve tool  

c) Left click to create a line just outside the straight stitches  

(1) The line should travel to the start point of the next Richelieu bar  

3. Left click on Apply Stitches  to open the menu 

4. Left click on Run   

a) In the Properties box, 

(1)  Set the stitch length at 1.5. 

(2) Confirm that the line is a single run 

(3) Left click Apply  

5. Left click on the Reform tool  and confirm that the start and stop points are in the 
correct position. 

6. Left click on the Artwork tool  to open the menu 

7. Select the Line tool  

8. Draw the line for the second Richelieu bar 

I. Left click on Apply Stitches  to open the menu 

1. Left click on Satin   

2. Change the width to 2.0 and click Apply  

3. Select the Reform tool   

a) Confirm that the green Start point is on one end of the line and the red Stop 
point is on the other end of the line. 

4. Select the Underlay tab in the Properties box 

a) Put checkmarks in both the Contour and the Zig-Zag types of underlay  

b) Left click Apply  
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J. Now that the bars are in place we can select the Appliqué shape around the cut area and 
return the applique density to the original setting 

1. In the Properties box, change the stitch length back to 0.4.   

2. Left click Apply  

K. The bars are on top of the appliqué, but we can take care of that by re-sequencing  

1. Select the applique ring for the large spot in the Sequence View 

2. Right click and select Move and Last 

L. Use Copy and Paste to create the large spot for the other wing 

1. Left click on Zoom to fit  

2. In the Sequence View, select both the Richelieu bars and the satin stitch ring 

3. Right click and Copy 

4. Right click and Paste 

5. Click and drag to move the pasted bars into place on the other wing. 
 

XIII. Preserve as Stitches 
A. You will want all the steps involved in cutting, sewing the Richelieu bars, and satin stitching to 
happen in the most efficient order. 

1. The most efficient way to do this would be to cut all of the openings for the reverse 
appliqué on the upper wings and the cutwork on 
the lower wings at the same time. 

2. And the Richelieu bars need to sew after the 
straight stitches of the appliqué and before the 
satin cover stitch. 

B. Unfortunately, although we can see the three separate 
steps of the appliqué process in each of these areas, we 
cannot move the straight stitches to one position in the 
sewing sequence and put the satin stitch in another 
position. 

1. Left click on the plus sign to the left of one of the appliqué spots and you will see that 
spot with the word appliqué next to it. 

2. Left click on the plus sign to the left of Appliqué and the list will open to show the three 

steps with their different colors that make up the appliqué ring. 
C.  Use Preserve as Stitches to Simplify the Sewing Process 

1. Is there a way to break up the appliqué steps so we can re-sequence them with the 
straight stitches all sewing first and the satin stitches sewing last? 

a) Yes! 

D. Tab the Sequence View to make it easier to see the entire stitching order of your design. 

1. Left click and drag the title bar of the Sequence View toward the right 
edge of the design page.  

2. As the Sequence View is pulled onto the edge of the design page, you 
will see a 4 headed arrow. 
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a) Left click in the center to change the Sequence View so it runs the entire 
length of the page. 

3. The Properties box will be automatically tabbed 
also. 

4. You will be able to view the Sequence View or 
Properties box by left clicking the tabs at the bottom 
edge of the panel. 

E. Let’s begin by taking a look at the reverse applique 
spots on the top wings 

1. Ideally the most efficient way to sew these spots 
would be to sew the first straight stitch outline on all 
four spots and then trim the fabric out of all four 
spots at the same time. 

2. Then if we could use a piece- of appliqué fabric 
large enough to cover all four spots and sew the 
second outline of all four spots, we could trim the 
appliqué fabric for all of the spots at the same time. 

3. Then the hoop could go back on the machine 
and sew all of the satin stitches at the same time. 

4. This would reduce the number of times we have 
to take the hoop off the machine to just twice 
instead of eight times! 

F. Select both spots on the one wing 

1. Left click on the first appliqué in the Sequence 
View, then hold down the Control key on the 
keyboard and select the second appliqué in the list. 

2. With both spots selected, right click and select Preserve as Stitches from the pop up 
list. 

3. And the appliqués have been changed to three separate steps! 

G. The Preserve as Stitches tool has taken the appliqué and saved it as stitches instead of a 
BLF editing object.   

1. You can no longer change the stitch settings in the Properties box 

a) And the Reform tool  is also grayed out for the three appliqué steps. 

b) The rest of your butterfly is still a BLF  

c) If you select any other object in the Sequence View, you will have full access 

to your stitch properties, and Reform tool  

2. You will want to wait and use Preserve as Stitches when you have completed your 
other editing. 

3. But the good news is that we will now be able to change the sewing order of the 
appliqué steps! 

H. Use Preserve as Stitches to separate the steps of all of the wing appliqués. 
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1. Select the next  two spots in the Sequence View 

2. Right click and select Preserve As Stitches  

3. Repeat for the cutwork spots on the lower wings. 

4. The Preserve as Stitches tool will work on one or two appliqué objects at a time, so 
select the appliqués in pairs.   

a) The tool is unable to break up three appliqués at the same time. 
 

XIV. Sewing Order 
A. Now the design can be re-sequenced 

1. Select All Items at the top of the Sequence View 

2. Left click on the Modify tab 

3. Left click on Color Sort  and the design is grouped by color.  

a) The color sort has grouped the straight stitches and the satin stitches by color, 
and part of our job has been done for us. 

4. Right click on any item in the Sequence View and select Collapse All 

a) The details of the Sequence View are closed up and we see just the list of 
colors in the design 

5. Hold down the Control key on the keyboard and select the four satin stitch colors. 

a) Left click on a pale yellow color chip in the Color Palette to change all of the 
satin stitches to the same color. 

6. Hold down the Control key on the 
keyboard and select all of the straight stitch 
colors except the second straight stitch for 
the reverse appliqué. 

a) Left click on a purple color chop 
in the Color Palette to change the 
selected straight stitches to the 
same color. 

b) The second straight stitch of the 
reverse appliqué needs to be a 
different color and sew separately 
to sew the appliqué fabric in place. 

7. Select All Items at the top of the Sequence View and left click on Color Sort  and 
the design is grouped by color. 

a) Right click on any item in the Sequence View and select Collapse All  
 

XV. Sewing the Butterfly 

A. Run the Sewing Simulator to see that the design is now sewing in the exact order needed. 

1. The outline of the wings, the antennae, and the body will sew first. 

2. Then the straight stitch outlines of all the cut areas will sew. 
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3. Remove the hoop from the machine and carefully cut out all of the open areas from 
the fabric without cutting the stabilizer 

4. Return the hoop to the machine 

5. Place the appliqué fabric under the hoop.   

a) Use a piece of fabric that is large enough so you can see it beyond the edges 
of the hoop and know that it is in the right place. 

6. Sew the second set of straight stitches 
around the appliqués in the top wing 

7. Remove the hoop from the machine and trim 
the appliqué fabric on the back of the hoop. 

8. Return the hoop to the machine and sew the 
remaining satin stitches. 

B. NOTE THAT THE DIFFERENT COLORS IN THIS 
DESIGN ARE USED TO FORCE THE MACHINE TO 
STOP SEWING WHEN WE NEED TO TRIM.  

1. The design should be sewn with the same 
color thread for all steps. 

C. If you are using a Baby Lock multi needle machine 
you need to remember that those machines treat color 
changes differently. 

1. Most embroidery machines see a color 
change as an instruction to stop sewing so the thread can be changed. 

2. The Baby Lock multi needle machines see a color change as an instruction to switch 
to a different needle and keep on sewing! 

3. If you are using a Baby Lock multi needle machine you will need to go to the Color 
Palette to instruct the machine to stop. 

a) Touch the Color Palette key  on the Edit screen of the machine 

b) Touch the next color key  to move the first of the straight stitch colors to 
the top of the list. 

c) Touch the key with a hand  

d) You will see the hand appear in the color list .  This hand tells the 
machine that it should stop before this color is sewn. 

e) Repeat the steps above to place a hand next to the second straight stitch color 

f) Once the instruction for the stop is in place, you can change all of the colors in 
the design to the same color in your Baby Lock multi needle machine so that the 
whole design will be sewn with the same needle. 
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Companion Products for this Sew at Home Class 
 

Sew at Home classes 
Upgrade to MasterWorks III #EDG-MW3TU 
Madiera Embroidery thread 40 wt 
Baby Lock Dissolve-Away Mesh #BLS 500 
Embroidery needles size 75/11 
Finishing Touch Bobbin Thread 
Gingher 4 inch curved scissors #G-4C for trimming embroidery threads 
Gingher 5 inch sewing scissors #G-5 for trimming applique fabric 

 
 
 


